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“All Photos” and “Last Import”
To view all pictures cataloged in PictureProject, select All 
Photos in the collection list.

To view the pictures most recently cataloged using 
PictureProject Transfer or the Import Assistant, select Last 
Import.

Collections
The pictures in the picture list can be grouped into collec-
tions organized by theme.  For example, travel pictures could 
be grouped together by creating a “Travel” collection and 
dragging all travel pictures into the new collection.  To dis-
play the pictures in the “Travel” collection, select Travel in 
the collection list.

All Photos

Collection list Picture list

Last Import
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One Picture, Many Collections
Each picture can belong to multiple collections.  For exam-
ple, a travel picture that was also a personal favorite could 
be cataloged in both the “Travel” and “My favorite” col-
lections.  PictureProject would list the same picture in both 
collections, but only one copy of the picture would be stored 
on the computer.

Transferring and Cataloging Pictures: Transferring and Cataloging Pictures: Collections and FoldersCollections and Folders  2/2

Folders
Collections can be grouped into folders.  For example, pic-
tures taken in 2004 could be cataloged in a folder labelled 
“2004” which is further subdivided into “Travel” and “My 
favorite” collections.  Selecting 2004 in the folder list would 
display the pictures in both these collections. 

  FoldersFolders
Pictures can not be directly placed in folders, nor can a folder be created 
inside a collection.

“Travel” collection “My favorite” collection

“2004” folder Pictures in
“Travel” collection

Pictures in
“My favorite” collection
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Transferring and Cataloging Pictures: Transferring and Cataloging Pictures: OriginalsOriginals

When pictures are retouched in PictureProject, any changes 
are automatically refl ected in the original fi le.  Use the “Re-
set” option in the “Photo Enhance” palette to cancel chang-
es, or select “Original” in the “Markers” palette to undo all 
changes and restore the original picture.

Changes and reset operations applied to the picture in one 
collection are automatically refl ected in all other collections 
to which the picture belongs.

  Editing PicturesEditing Pictures
File size increases when pictures are retouched (this does not affect 
the size of copies created with the Export JPEG/TIFF… option).  Files 
are restored to approximately their original size when Revert to Origi-
nal… is selected in the Photo menu or “Original” is selected in the 
“Markers” palette.

  Nikon Capture 4Nikon Capture 4
The picture list for organize mode does not refl ect changes made to 
NEF pictures using the Digital DEE, Image Dust Off, or Noise Reduction 
tools in Nikon Capture 4 Version 4.1 or later.  The results of Image Dust 
Off and Noise Reduction are however displayed when NEF pictures are 
viewed in edit mode.  Changes made using Digital DEE are not visible 
in edit mode.

  Capture NXCapture NX
Only changes to Basic Adjustments (Camera Adjustments, RAW Adjust-
ments, Lens Adjustments, Light & Color Adjustments, and Detail Adjust-
ments) are refl ected when NEF pictures modifi ed in Capture NX are ed-
ited in PictureProject.  Other changes made in Capture NX will be lost.

Undo changes

Retouch picture
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Transferring and Cataloging Pictures: Transferring and Cataloging Pictures: Cataloging FoldersCataloging Folders  

2 The folder containing the 
pictures to be cataloged is 
listed under “Import from.”  
To import pictures from 
a different folder, select 
Choose Folder… from 
the Select import folder 
menu and navigate to the 
desired location.

3 Click Import to catalog 
all pictures in the location 
listed under “Import from” 
(pictures that have already 
been cataloged will not be 
cataloged again).

This section describes how all pictures in selected folders on 
the computer hard disk can be cataloged using the Import 
Assistant.

1 Select Import Assistant… 
from the File menu to dis-
play the Import Assistant.

4 The dialog shown at right 
will be displayed; click OK.  
The newly-cataloged pic-
tures will be displayed in 
the PictureProject picture 
list.

  “Copy Photos into PictureProject”“Copy Photos into PictureProject”
Select this option to copy the pictures to the folder selected in the 
“Transfer Destination” tab of the “Transfer Options” dialog.

  “Options…”“Options…”
Clicking this button displays the “Rename Photos” tab of the “Transfer 
Options” dialog, where you can choose how pictures will be named 
in PictureProject (if Copy photos into PictureProject is selected, fi le 
names will also be changed).  Any changes will also be refl ected in the 
“Rename Photos” tab of the “Options” (“Preferences”) dialog.

  Folders and CollectionsFolders and Collections
A collection is created for each source folder that contains pictures.  
Any sub-folders are listed as collections inside a folder with the same 
name as the source folder.  For example, if pictures are imported from 
the “2004” folder in “My Pictures,” the pictures will be cataloged in a 
“2004” collection at the top level of the collection list.  If the “2004” 
folder also contains an “April” sub-folder, the pictures will be cataloged 
in an “April” collection inside a folder named “2004”.
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To select pictures for transfer:

1 Start PictureProject Transfer by connecting the camera 
and turning it on, inserting the camera memory card in a 
card reader or PC card slot, or selecting PictureProject 
Transfer from the PictureProject File menu.

2 Click the 

▲

 next to Show thumbnails to view the pic-
tures on the camera memory card.  If multiple memory 
cards are available (e.g., a camera is connected while a 
memory card is inserted in a card reader), select the de-
sired card in the Transfer from menu.

3 Select pictures for transfer.

Using the mouseUsing the mouse
Click a picture once to select it.  To select multiple pic-
tures, press the Ctrl key (Windows) or  key (Macintosh) 
while clicking pictures one at a time, or click two pictures 
while pressing the shift key to select the pictures and all 
images between them.  To deselect, click pictures while 
pressing Ctrl (Windows) or  (Macintosh).

Using the controls in the transfer windowUsing the controls in the transfer window

Transferring and Cataloging Pictures: Transferring and Cataloging Pictures: Selecting Pictures for TransferSelecting Pictures for Transfer

Button Description

Select all protected pictures.

Select all pictures.

Select all pictures marked for transfer.

Deselect all pictures.

Delete selected pictures from memory card.

Group pictures by Folder, Extension, or Shooting 
Date.  Shooting Date is not available with D1-series 
cameras under Mac OS X.  “.mov” fi les are treated as 
undated under PTP.

Pictures on memory card appear as thumbnail images.  
Pictmotion movies are indicated by  icon (Windows only).

Selected
pictures 

highlighted 
in blue

4 Click Transfer to transfer the pictures or Cancel to exit 
without transferring pictures.
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Delete unprotected pictures from memory card after successful 
transfer

Place in new collection / Place in new folder
To automatically place pictures in a collection after transfer:

1 Select the Place in option and enter a new collection or 
folder name in the text box (the default name is “Trans-
fer” followed by the current year, month, and day).

Open “Trans-
fer Options” 
dialog

The following transfer options are available: 2 Click Options to display 
the “Transfer Options” dia-
log.  The following options 
are available under “Trans-
fer Collections”:
• Place all photos in one new collection: Place pictures in 

the collection selected in Step 1.
• Separate photos by folders on camera: Pictures will be 

placed in the folder selected in Step 1, where they will 
be sorted into collections named for the source folders 
on the camera.

• Separate photos by shooting date: Pictures will be 
placed in the folder selected in Step 1, where they will 
be sorted into collections by date of recording.

• Create Collections inside the “Transfer” folder: Create 
all new albums and folders in the PictureProject “Trans-
fer” folder.

3 After clicking OK to close the “Transfer Options” dialog, 
click Transfer to transfer the pictures and place them in 
the selected collection.

Transferring and Cataloging Pictures: Transferring and Cataloging Pictures: Transfer OptionsTransfer Options  1/4

  “Place In”“Place In”
This option appears as Place in new collection if Place all photos in 
one new collection is selected in the “Transfer Options” dialog, or as 
Place in new folder if Separate photos by folders on camera or 
Separate photos by shooting date is selected.

Place pictures in
collection after transfer 
(see below)

Ignore pictures that 
have already been 
transferred to computer

  Voice Recordings (Applicable Cameras Only)Voice Recordings (Applicable Cameras Only)
PictureProject will only transfer voice memos that have been appended 
to the selected pictures.  Independent voice recordings can be copied 
manually when the camera USB option is set to Mass Storage.
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Rotate image automatically (supported cameras only): If this 
option is selected, pictures marked as having been taken in 
“tall” (portrait) orientation will automatically be rotated 90 ° 
left or right when transferred.  Pictures taken with cameras 
that do not record camera orientation will not be rotated.

Transfer Collections: See “Placing Pictures in Collections.”

Synchronize camera date and time to your computer clock 
when you connect your camera: If this option is selected, 
the camera clock will automatically be synchronized with 
the computer clock when connected (when using a camera 
with a USB interface, set the camera USB option to PTP).  
Click Synchronize Now to synchronize the camera clock 
immediately.

Transferring and Cataloging Pictures: Transferring and Cataloging Pictures: Transfer OptionsTransfer Options  2/4

  Synchronize Date and TimeSynchronize Date and Time
This feature is available with cameras with an IEEE 1394 (FireWire) inter-
face (D1-series cameras) or a USB interface that supports PTP.  Before 
synchronizing the camera and computer clocks, check that the com-
puter clock is set to the correct date and time.

  The “Pictmotion” TabThe “Pictmotion” Tab
See the “Pictmotion” section in the tutorial for information on the 
“Pictmotion” tab.

The “Transfer Options” Dialog
The “Transfer Options” dialog contains the following:

The “General” Tab
Copy all fi les marked as “Hid-
den” (Windows only): Select 
this option to include hidden 
fi les when transferring pic-
tures from the camera.

Embed ICC color profi le 
during transfer: Embed ICC 
color profi les in TIFF or JPEG 
photographs taken with the 
D1 (NTSC) or with digital SLR 
cameras using a color mode 
or color space adapted to 
Adobe RGB. 

Embed a preview image in NEF fi les: This option applies only 
to pictures created at an image quality of NEF (RAW)+JPEG.  
If this option is selected, a preview will be embedded in the 
RAW image when the fi le is transferred.
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Sample Name: Shows how sub-folders will be named.

Prefi x: The characters appended at the beginning of sub-
folder names.  Select No prefi x to omit the prefi x, or Text 
to enter a prefi x in the text box.

Index: Select Sequential Num ber to name sub-folders us-
ing numbers assigned in ascending order from the number 
entered in the Start numbering at text box.  The number 
of digits can be chosen using the arrows or by entering a 
number in the Number of digits text box.  Choose Trans-
fer date to name sub-folders using the date of transfer, or 
Transfer date and time to use the date and time of trans-
fer.  The date and time is of the form YYYY-MM-DD-HH-
MM-SS-NN, where YYYY de notes the year, MM the month, 
DD the day, HH the hour, MM the minute, SS the second, 
and NN the serial number added if a folder with the selected 
name al ready exists.  The characters that will separate the 
year, month, and day, the hour, minute, and second, and the 
serial number can be entered in the separator text boxes.

Suffi x: The characters appended at the end of sub-folder 
names.  Select No suffi x to omit the suffi x, or Text to enter 
a suffi x in the text box.

The “Transfer Destination” Tab
Choose a storage location for 
transferred fi les.  

Transfer destination folder: 
The current destination.  The 
default is the “PictureProject” 
folder in “My Documents \ My 
Pictures” or “My Documents” 
(Windows) or in “User / (user 
name) / Pictures” (Macintosh).  
To choose a new folder, click 
Browse….

Create a new subfolder for 
each transfer: Create a new destination sub-folder with each 
transfer.  The remaining settings in this tab are available only 
when this option is selected.

Copy folder names from camera: Choose this option to store 
transferred pictures using the folder hierarchy and folder 
names (e.g., “100NIKON”) on the camera memory card.

  FoldersFolders
All references to “folders” and “subfolders” in the “Transfer Destina-
tion” tab refer to folders in the computer fi le system, not the folders 
used in PictureProject used to group collections.
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Index: Select Sequential Num ber to name fi les using num-
bers assigned in ascending order from the number entered 
in the Start numbering at text box, or select Reset to 1 
before each transfer to restart numbering from 1 with 
each transfer.  The number of digits can be chosen using the 
arrows or by entering a number in the Number of digits 
text box.  Choose Shooting date to name fi les using the 
date of recording, or Shooting date and time to use the 
date and time of recording.  The date and time is of the form 
YYYY-MM-DD-HH-MM-SS-NN, where YYYY de notes the 
year, MM the month, DD the day, HH the hour, MM the min-
ute, SS the second, and NN the serial number added if a fi le 
with the selected name al ready exists.  The characters that 
will separate the year, month, and day, the hour, minute, and 
second, and the serial number can be entered in the separa-
tor text boxes.

Suffi x: The characters appended at the end of new fi le 
names.  Select No suffi x to omit the suffi x, Text to enter a 
suffi x in the text box, or Original name to use the camera 
fi le name.

The “Rename Photos” Tab
Choose how transferred fi les 
are named.  

Rename photos during trans-
fer: Name fi les using the op-
tions described below.  The 
names assigned will also be 
used as the default picture 
names in PictureProject.

Sample Name: Shows how 
fi les will be named.

Prefi x: The characters ap-
pended at the beginning of new fi le names.  Select Original 
name to use the camera fi le name, Text to enter a prefi x in 
the text box, or No Prefi x to omit the prefi x altogether.

  The “Rename Photos” TabThe “Rename Photos” Tab
Changes in the “Rename Photos” tab also apply to import, to the 
Import Assistant, and to the “Rename Photos” tab in the “Options” 
(“Preferences”) dialog.
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Organizing and Viewing Pictures: Organizing and Viewing Pictures: Organize ModeOrganize Mode  1/2

Organize mode is used when organizing and viewing pictures:

Menu bar
The menus available in the Macintosh version of PictureProject 
differ slightly from those shown here.

The Collection List
Lists folders and collections created using PictureProject.  Select 
All Photos to view all cataloged pictures or Last Import to view 
the pictures most recently transferred from the camera or im-
ported to PictureProject.  To view the pictures in a specifi c collec-
tion or folder, select it in the collection list.  To rename a collec-
tion or folder, select it and choose Rename from the Edit menu.  
Folders or collections can be moved or copied to a new location in 
the collection list by drag and drop. 

The collection list area contains the following buttons:

The Picture List
Lists pictures in the select-
ed folder or collection.  See 
Thumbnails and Previews.

Palettes
Search for pictures, or view 
fi le properties, information, or 
keywords associated with the 
selected picture.

Button Description

Create folder under selected folder (if All Photos or Last Im-
port is selected, folder will be created at top level of collec-
tion list).  Folder can not be created if collection is selected.

Create collection (see “Collections”).

Copy selected folder or collection.

  FoldersFolders
In PictureProject, folders are used to group collections.  Pictures can not 
be directly placed in folders, nor can a folder be created inside a collec-
tion.  If a folder is selected when pictures are cataloged, the pictures will 
be added to a new collection under the selected folder.

Click this button to hide the 
collection list and increase the 
size of the picture list.  To view 
the collection list, click again 
or select Show Collection List 
from the Window menu.

Click this button to hide pal-
ettes and increase the size 
of the picture list.  To view 
palettes, click again or select 
Show Palettes from the Win-
dow menu.

Toolbar: Lists the 
tools available in 
PictureProject.
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Folders and collections can be moved and copied by drag 
and drop.

To copy a folder or collection in its current location, select it 
and click the  button.  To copy collections or folders to a 
new location, select the desired items while pressing the Ctrl 
(Windows) or option (Macintosh) key and then drag them 
to the destination folder.

Without releas-
ing mouse button, 
drag collection to 
destination folder.

Release mouse
button.

Select collection 
while pressing Ctrl 

(option) key.

To move collections or folders, select the desired items and 
drag them to the destination folder.

Without releas-
ing mouse button, 
drag collection to 
destination folder.

Release mouse
button.

Select collection.

  Copying Folders and CollectionsCopying Folders and Collections
Copying a folder or collection does not create copies of cataloged im-
age fi les.  Use standard Windows or Finder operations to back up image 
fi les.

  Moving or Copying Items to the Top of the Collection ListMoving or Copying Items to the Top of the Collection List
To copy or move a collection or folder to the top level of the collection 
list, drag it into All Photos or Last Import.

  Dragging Items from Windows Explorer or the FinderDragging Items from Windows Explorer or the Finder
Dragging a folder into the collection list from Windows Explorer 
(Windows) or the Finder (Macintosh) creates a new collection with the 
same name, as described in “Cataloging Folders.”  If a collection with 
the same name already exists, the pictures will be added to that col-
lection.  Performing this operation while pressing Ctrl (Windows) or 
option (Macintosh) copies the pictures to the folder selected in the 
“Transfer Destination” tab of the “Transfer Options” dialog.

Organizing and Viewing Pictures: Organizing and Viewing Pictures: Organize ModeOrganize Mode  2/2

To reorder collections or folders, select 
an item and drag it to a new location in 
the collection list.
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Organizing and Viewing Pictures: Organizing and Viewing Pictures: Using PalettesUsing Palettes  

Hiding Palettes
Click this button to hide all palettes and 
increase the size of the picture list.  To 
view palettes, click again or select Show 
Palettes from the Window menu.

Reordering Palettes
To move a palette up or down in the pal-
ette list, select it and drag the title bar to 
a new location.

Resizing the Information Palette
The information palette can be resized by 
dragging the resize tab at the bottom of 
the palette.  The scroll bar can be used to 
view information not currently visible in 
the palette.

Opening and Closing Palettes
To open a palette, click the 

▲

 in the pal-
ette title bar.  Click again to close the 
palette.

Scroll bar

Resize tab

Select palette

Release mouse button

Drag to desired location
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Organizing and Viewing Pictures: Organizing and Viewing Pictures: The Properties PaletteThe Properties Palette  1/2

Renaming Pictures
Pictures in PictureProject have names independent of the 
picture fi le name.  Changing this name does not rename the 
fi le.  To rename individual pictures:

1 Click the Organize button and click the 

▲

 next to Prop-
erties to open the properties palette.

2 Select a picture in the picture list and enter a new name 
in the Name text box.

Picture list

Properties palette

� Click Organize

� Click 

▲

� Select picture

� Enter name

To rename multiple selected 
pictures, select Show Name 
for Extras in the View menu 
and choose Rename from 
the Edit menu.  The options 
shown at right will be dis-
played.

• Add suffi x to the original photo name: Rename the se-
lected pictures by adding the suffi x in the Suffi x text box 
to the original picture name.

• Rename with new numerical sequence: Rename the se-
lected pictures by adding numbers assigned in ascending 
order to the prefi x in the Prefi x text box.  The number of 
digits can be chosen using the Number of digits slider.

If Show Name is selected in for Extras in the View menu, 
pictures can also be renamed by selecting the picture and 
clicking the name or choosing Rename from the Edit menu.  
Enter a new name and press enter.

  RenameRename
The Rename option in the Edit menu is only available when Show 
Name is selected for Extras in the View menu.  Show Name is not 
selected by default.

  Edit ModeEdit Mode
The properties palette is also available in edit mode.
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Item Description

Date Date selected picture was last modifi ed.

File name of selected picture.File Name

File size and dimensions of selected picture.Size

Hidden
Check this option to hide selected picture (Windows 
only).

Check this option to tag selected picture for future 
reference or to aid in searches.

Tag
Marked

Check this option to protect selected picture from 
editing and accidental deletion.

Protect
Locked

Properties

Viewing and Changing File Properties
To view and modify fi le properties for selected pictures:

1 Click the Organize button and click the 

▲

 next to Prop-
erties to open the properties palette.

2 Select a picture in the picture list.  The following informa-
tion is displayed in the properties palette:

Property buttons

Properties palette

� Click Organize

� Click 

▲

� Select picture

Picture name (see “Renaming Pictures”).Name

  “Tag Marked,” “Protect Locked,” and “Hidden” Properties“Tag Marked,” “Protect Locked,” and “Hidden” Properties
These properties can also be turned on or off using the property but-
tons in the picture list or the Tag Mark Photo(s), Protect Photo(s), 
and Hidden Photo(s) options in the Photo menu.

  Hidden Pictures (Windows Only)Hidden Pictures (Windows Only)
Hidden pictures are displayed in PictureProject when (Off) or Hidden 
only is selected for Hidden in the search fi lter palette properties list.

  Retouching Protected PicturesRetouching Protected Pictures
Protected pictures can not be retouched.  Turn protection off before 
retouching pictures.

  AttributesAttributes
When Show Icons is selected for Extras in the 
View menu, fi le attributes are shown by icons 
under the pictures in the picture list.

Icon Description
Tagged picture
Protected picture
Hidden picture
Edited JPEG or TIFF picture
Original RAW picture
Original RAW picture with 
preview
Edited RAW picture

Icon Description
Edited RAW picture with 
preview
Picture smaller than 640 × 
480 pixels.
Movie
Picture with voice memo
Picture with IPTC informa-
tion or keyword

Picture list
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File Information
Lists the fi le name, location, and 
dates of creation and last modifi -
cation for the selected picture (the 
Windows version also lists date of 
last access).  To open the folder 
containing the selected picture, 
click Open with Explorer (Windows) 
or Open in Finder (Macintosh).

Shooting Data
Lists information about the camera 
settings in effect when the picture 
was taken.  The information dis-
played varies with the make of cam-
era and the type of picture.

Organizing and Viewing Pictures: Organizing and Viewing Pictures: Viewing Photo InformationViewing Photo Information  1/2

To view information on selected pictures:

1 Click the Organize button.

2 Click the 

▲

 next to Information to open the information 
palette.

3 Select a picture in the picture list and choose the infor-
mation to be displayed from the pull-down menu.  The 
following options are available: Shooting Data, File 
Information, Voice Memo, Collection Information, 
General (IPTC), Origin (IPTC), and Detail (IPTC).

Picture list

Information palette

� Click Organize

� Click 

▲

� Select picture…

…and choose option



Index Getting Started PictureProject Tutorial PictureProject Reference Technical Notes

Next 17BackTop

Voice Memo
Lists the fi le name, location, dates 
of creation and last modifi cation, 
and length of any voice memo as-
sociated with the selected picture 
(the Windows version also lists date 
of last access).  Click Play to play the 
voice memo or  Delete to delete it.

Collection Information
Lists the folders and collections in 
which the selected pictures is cata-
loged.

Organizing and Viewing Pictures: Organizing and Viewing Pictures: Viewing Photo InformationViewing Photo Information  2/2

General (IPTC) / Origin (IPTC) / Detail (IPTC)
These palettes list the IPTC informa-
tion for the selected picture.  To add 
information, enter the appropriate 
data in the text boxes and click 
Apply.  Click Reset to undo any 
changes.

General (IPTC) palette

  Interrupting PlaybackInterrupting Playback
During voice memo playback, the Play button changes to Stop.  Click 
to interrupt playback.

  File > Play Voice Memo / Stop Voice MemoFile > Play Voice Memo / Stop Voice Memo
These options can be used to start and stop voice memo playback.

  IPTCIPTC
IPTC information may appear under different titles in other applica-
tions.
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Organizing and Viewing Pictures: Organizing and Viewing Pictures: Organizing Pictures by KeywordOrganizing Pictures by Keyword  1/2

In PictureProject, the user can defi ne keywords (for example, 
“Kids” or “Travel”).  These keywords can then be added to 
pictures, making them easier to fi nd at a later date.

To defi ne keywords:

1 Click the Organize button.

2 Click the 

▲

 next to Keywords to open the keywords 
palette.

To add up to twenty keywords to a picture:

1 Select the picture in the picture list.

2 Open the keywords palette and check the keywords that 
apply to the selected picture.  To remove keywords from 
the picture, remove the check from the box.

� Click 

▲

� Click New...

Keywords palette

� Click Organize

Note: To display an IPTC keyword icon ( ) below pictures with 
keywords, select Extras > Show Icons in the View menu.

3 Click New….  The following dialog will be displayed; en-
ter a new keyword and click OK.  The new keyword will 
be added to the list in the keywords palette.

Keyword
OK button
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Organizing and Viewing Pictures: Organizing and Viewing Pictures: Organizing Pictures by KeywordOrganizing Pictures by Keyword  2/2

To change existing keywords:

1 Open the keywords panel and click  Rename / Delete….

2 The following dialog will be displayed.  Select a keyword 
and click Rename….

3 Enter a new keyword and click OK.

To delete keywords:

1 Open the keywords panel and click  Rename / Delete….

2 The following dialog will be displayed.  Select a keyword 
and click Delete.

  Searching for Pictures by KeywordSearching for Pictures by Keyword
See “Finding Pictures“ for information on searching for pictures by 
keyword.

Rename / Delete…
button

Keywords palette

Rename… 
button

Selected
keyword

Keyword
OK button

Rename / Delete…
button

Keywords palette

Delete
button

Selected
keyword

3 Click OK to delete the keyword.
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Retouching Pictures: Retouching Pictures: The Edit DisplayThe Edit Display  

The edit display contains the following tools:

  Saving ChangesSaving Changes
PictureProject automatically saves changes to pictures.  Use the “Markers” palette to restore the picture to a previously saved state.

  File SizeFile Size
File size increases when pictures are retouched.

Rotate pictures 90 ° clockwise.

Rotate pictures 90 °
counterclockwise.

Cursor changes to .  Click to zoom in on pictures.  To zoom out, 
click while pressing Alt key (Windows) or option key (Macintosh).  
Cursor changes to  while key is pressed.

Cursor changes to .  Drag 
mouse over picture to select crop, 
or select crop size from menu.

Select edit mode.

Current zoom ratio.

Cursor changes to .  Drag 
picture to view areas not visible 

in the display.

File name of current picture.

Display previous picture in
current collection or folder.

Display next picture in current
collection or folder.

Reduce red-eye.

View and edit keywords.

Click to hide or display changes 
(rotations excluded).

Retouch pictures using the
tools in this palette.

View items in current collection or 
folder; select pictures for editing.

Record changes made in edit 
mode.

See “Using Palettes” for more 
information on viewing and reor-

dering palettes.

View photo information.
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Retouching Pictures: Retouching Pictures: Adjusting BrightnessAdjusting Brightness  

To correct exposure in pictures in which the main subject is 
under- or over-exposed or in which the background is much 
brighter or darker than the main subject:

1 Select the collection or folder containing the desired pic-
ture in the collection list.

2 Double-click the picture, or select the picture in the pic-
ture list and click Edit.

  Reset / Auto AdjustReset / Auto Adjust
Click Auto Adjust to optimize exposure for the selected picture.  To 
reset changes to exposure, click Reset.

Note: When exposure is altered, a check will appear next to 
Brightness.  Remove the check to undo the effects of expo-
sure correction.

3 Click the 

▲

 next to Photo Enhance and select Bright-
ness in the photo enhance palette.

4   Adjust exposure by ±100 using the Brightness slider.  
Move the slider to the left to make the picture darker, 
to the right to make the picture brighter.  To bring out 
details in shadows, select Enhance Dark Tones.

Photo Enhance

� Select
Brightness

� Drag Bright-
ness slider 
left or right 
with mouse

Picture list

… and click Edit

Collection list

� Select collection

� Select picture…
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To bring out details in overexposed areas of highlights or in 
underexposed or backlit shadows:

1 Select the collection or folder containing the desired pic-
ture in the collection list.

2 Double-click the picture, or select the picture in the pic-
ture list and click Edit.

3 Click the 

▲

 next to Photo Enhance and select D-Light-
ing HS in the photo enhance palette.

4 Choose Low, Normal, or High from the D-Lighting HS 
menu.

  ResetReset
Click Reset to undo the effects of D-Lighting HS.

Retouching Pictures: Retouching Pictures: D-Lighting HSD-Lighting HS  

Picture listCollection list

� Select collection

� Select picture…

Photo Enhance

� Select
D-Lighting HS

� Click here and 
select option 
from menu

Note: A check next to D-Lighting HS indicates that D-Light-
ing HS has been adjusted.  Remove the check to undo the 
effects of D-Lighting HS.

… and click Edit
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To make colors more vivid:

1 Select the collection or folder containing the desired pic-
ture in the collection list.

2 Double-click the picture, or select the picture in the pic-
ture list and click Edit.

3 Click the 

▲

 next to Photo Enhance and select Color 
Booster in the photo enhance palette.

4 Choose a picture type.  Select People to adjust colors 
without affecting skin tones, Nature to adjust all colors.

5 Adjust vividness by 0–100 using the Color Booster 
slider.  Moving the slider to the right increases vividness.

  Reset / Auto AdjustReset / Auto Adjust
Click Auto Adjust to optimize chroma for the selected picture.  To reset 
changes to color, click Reset.

Retouching Pictures: Retouching Pictures: Adjusting Colors (Color Booster)Adjusting Colors (Color Booster)  

Picture list

… and click Edit

Collection list

� Select collection

� Select picture…

Note: When colors are altered, a check will appear next to 
Color Booster.  Remove the check to undo the effects of the 
color booster.

Photo Enhance

� Select People 
or Nature

� Drag Color 
Booster slider 
with mouse

� Select Color 
Booster
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To convert pictures to sepia or black-and-white:

1 Select the collection or folder containing the desired pic-
ture in the collection list.

2 Double-click the picture, or select the picture in the pic-
ture list and click Edit.

3 Click the 

▲

 next to Photo Enhance and select Photo 
Effects in the photo enhance palette.

4 Choose Black & white or Sepia from the Photo Ef-
fects menu.

  ResetReset
Click Reset to restore the original colors.

Retouching Pictures: Retouching Pictures: Converting Pictures to Sepia and Black-and-WhiteConverting Pictures to Sepia and Black-and-White  

Picture list

… and click Edit

Collection list

� Select collection

� Select picture…

Photo Enhance

� Select Photo 
Effects

� Click here and 
select option 
from menu

Note: When a picture is converted to sepia or black-and-
white, a check will appear next to Photo Effects.  Remove 
the check to restore the original colors.



Index Getting Started PictureProject Tutorial PictureProject Reference Technical Notes

Next 25BackTop

Sharpness can be increased to make outlines more distinct, 
or lowered to soften outlines.  To adjust sharpness:

1 Select the collection or folder containing the desired pic-
ture in the collection list.

2 Double-click the picture, or select the picture in the pic-
ture list and click Edit.

3 Click the 

▲

 next to Photo Enhance and select Sharpen-
ing in the photo enhance palette.

4 Select None, Low, Medium, or High from the Sharp-
ening menu.

Retouching Pictures: Retouching Pictures: Sharpening OutlinesSharpening Outlines  

Picture list

… and click Edit

Collection list

� Select collection

� Select picture…

  ResetReset
To reset changes to sharpening, click Reset.

Note: When sharpening is altered, a check will appear next 
to Sharpening.  Remove the check to undo changes to sharp-
ening.

Photo Enhance

� Select
Sharpening

� Select option 
from Sharp-
ening menu
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To straighten pictures:

1 Select the collection or folder containing the desired pic-
ture in the collection list.

2 Double-click the picture, or select the picture in the pic-
ture list and click Edit.

3 Click the 

▲

 next to Photo Enhance and select Straight-
en in the photo enhance palette.

4 Use the Straighten slider to adjust the angle of the 
picture by ±10 ° in increments of 0.01 °.  Drag the slider 
to the right to rotate the image clockwise, to the left to 
rotate the image counterclockwise.

Retouching Pictures: Retouching Pictures: Straightening PicturesStraightening Pictures  

Picture list

… and click Edit

Collection list

� Select collection

� Select picture…

  ResetReset
To reset changes to straightening, click Reset.

Photo Enhance

� Select
Straighten

� Drag 
Straighten 
slider with 
mouse

Note: When the angle of the picture is altered, a check will 
appear next to Straighten.  Remove the check to undo the 
changes.
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3 Click the  button.  The cursor will 
change to  and Auto-Removal 
and Reset options will appear in the edit area.  Move the 
cursor over the image until the cursor changes to .  If the 
area under the cursor is affected by red-eye, click to correct 
red-eye in the affected area.

Light refl ected from the camera fl ash may sometimes cause 
the pupils of the subject’s eyes to appear red.  To correct for 
“red-eye”:

1 Select the collection or folder containing the desired pic-
ture in the collection list.

2 Double-click the picture, or select the picture in the pic-
ture list and click Edit.

  Photo > Auto RedeyePhoto > Auto Redeye
Automatic red-eye correction can also be performed by selecting Auto 
Redeye from the Photo menu.

Retouching Pictures: Retouching Pictures: Red-Eye CorrectionRed-Eye Correction  

Picture list

… and click Edit

Collection list

� Select collection

� Select picture…

Auto-Removal: If this option is checked, the picture has 
already been edited using the  (Auto Red-eye) tool.  
Remove the check from this option to undo the effects 
of auto red-eye correction.

Reset: Undo all changes made using red-eye correction.

Click  button.

…click to correct 
red-eye.

Move  cursor over picture.  
When cursor changes to …
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Retouching Pictures: Retouching Pictures: Cropping PicturesCropping Pictures    

To crop pictures:

1 Select the collection or folder containing the desired pic-
ture in the collection list.

2 Double-click the picture, or select the picture in the pic-
ture list and click Edit.

Picture list

… and click Edit

Collection list

� Select 
collection

� Select 
picture…

  Adjusting the CropAdjusting the Crop
To move the crop, drag it to a new position.  The size of the crop can be 
adjusted by dragging its borders.

  Undoing CropsUndoing Crops
After a crop is applied, the Apply button will change to Edit.  Click Edit 
to undo the last crop, or click Reset to restore the original, uncropped 
picture.

3 Click the  button.  The cursor 
will change to .

4 Select the desired crop size and 
orientation from the Crop menu.

5 Drag the mouse over 
the image to select a 
crop.

6 Click Apply.
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Retouching Pictures: Retouching Pictures: Recording Changes (Markers)Recording Changes (Markers)    

Changes to pictures in edit mode can be recorded using 
the “Markers” palette.  For example, creating “print” or “e-
mail” markers after editing a picture for printing or e-mail 
allows these settings to instantly be restored whenever the 
picture is printed or mailed.

1 After editing a picture, open 
the markers palette and click 
Add.

Selecting the marker in the markers palette will now restore 
the picture to the state it was in when the marker was cre-
ated.  Preset markers are available for restoring pictures to 
their original or current state; a “Last Saved” marker is also 
available to restore edited images to the state they were in 
at the beginning of the current session.

To delete a marker, select it in the markers palette and click 
Delete.

2 Enter a marker name and click OK.  The new marker will 
be added to the markers palette.

  “Original”“Original”
Pictures can also be restored to their original state by selecting Revert 
to Original in the Photo menu.
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Retouching Pictures: Retouching Pictures: Exporting Pictures in JPEG and TIFF FormatsExporting Pictures in JPEG and TIFF Formats  

To create JPEG or TIFF copies of selected pictures:

1 Select the collection or folder containing the desired pic-
tures in the collection list.

2 Select pictures in the picture list and choose Export 
JPEG/TIFF… from the File menu.

3 The dialog shown at right 
will be displayed.  The fol-
lowing options are avail-
able:
• Format: Choose JPEG or 

TIFF.
• Resize: To copy pictures 

at a new size, select this option and choose the desired 
size from the menu.

• Quality (JPEG only): Choose how copies will be com-
pressed.

• Change File Names: Select this option to save copies 
under new names.  The current naming rule is shown 
in the “Sample Name” area.  To change the naming 
rule, click Naming Options….

4 Click Export to copy the selected pictures.

Picture listCollection list

� Select pictures…

� Select collection

… and select Export 
JPEG/TIFF… in File menu 
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3 ArcSoft Panorama Maker will start and automatically 
choose a pan direction.  Click Next.

  Panorama Maker HelpPanorama Maker Help
For help on using Panorama Maker, click the ? (help) button.

Retouching Pictures: Retouching Pictures: Creating a PanoramaCreating a Panorama  1/2

Pictures taken using the “Panorama Assist” option available 
with some Nikon COOLPIX cameras can be joined together 
to form a panorama:

1 Click Organize and select the collection or folder con-
taining the desired pictures in the collection list.

2 Select pictures in the picture list and choose Make Pan-
orama… from the Photo menu. 

  Panorama MakerPanorama Maker
Panorama Maker is provided only with COOLPIX cameras.

Picture list

� Select collection

� Select pictures…

Collection list

… and select Make
Panorama from Photo 

menu 

4 Panorama Maker will automatically arrange all selected 
pictures in order to create a panorama.  Click Next.

Pictures in 
panorama

Selected 
pictures

Help
button
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5 A preview will be displayed.  Use the Fine Tune tool to 
manually adjust the position of the pictures in the pan-
orama.  Click Finish to proceed to the next step.

Retouching Pictures: Retouching Pictures: Creating a PanoramaCreating a Panorama  2/2

6 Click Save to save the completed panorama.

7 Choose a location and fi le name and click Save.

8 Exit Panorama Maker.
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Clicking Add… displays the 
dialog shown at right; click 
Browse… and select an ap-
plication.  Enter a name for 
the application in the Name 
text box and click OK.

To change a listed appli-
cation, select it and click 
Change….  The dialog 
shown at right will be dis-
played; enter a new name or 
click Browse… to choose a 
new application.

Retouching Pictures: Retouching Pictures: Opening Pictures in Other ApplicationsOpening Pictures in Other Applications  

To open pictures in other applications:

1 Click Organize and select the collection or folder con-
taining the desired picture in the collection list.

2 Select pictures in the picture list and choose an applica-
tion from the File> Open with menu.  The selected pic-
tures will be opened in the chosen application.

� Select collection

To change the applications listed, choose Add / Remove 
program….  The following dialog will be displayed.

Move selected application up 
in application list

Move selected application 
down in application list

Add application

Change selected application

Remove selected application

Picture listCollection list

� Select pictures…

… and select application 
from File> Open with menu 
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Design Mode: Design Mode: The Design Mode DisplayThe Design Mode Display  

Click to add a page 
to the layout.

Click to delete the current 
page from the layout.

Choose how pictures are displayed 
in the design area.

The current page.

View the next page.View the previous page.

Adjust text attributes or view 
information about selected pic-
tures.

Choose a layout.

View thumbnails of the pictures 
in the current collection or folder.  
To add pictures to the layout, 
drag them into the design area.

Select design mode.

Design mode is used to arrange selected pictures in multi-page layouts.

See “Using Palettes” for more 
information on viewing and 

reordering palettes.

Zoom ratio
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Design Mode: Design Mode: View OptionsView Options  

Click the  (“Page”),  (“Thumbnail”), or  (“Page and Thumbnail”) buttons at the bottom of the design area to choose 
a view.

 (“Page”)  (“Thumbnail”)  (“Page and Thumbnail”)

View thumbnail previews of all pages in the 
current layout.  Use the scroll bar to view ad-
ditional pages, or use the slider to adjust the 
size of the previews.  Select pages by clicking a 
thumbnail or using the  and  buttons.

Thumbnails are listed at the top of the design 
area with the current page at the bottom.  Se-
lect the current page by clicking a thumbnail or 
using the  and  buttons.

View the layout one page at a time.  Use the  
and  buttons to preview additional pages.
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Design Mode: Design Mode: The Properties and Layouts PalettesThe Properties and Layouts Palettes  

The Properties Palette
Lists the properties of the selected item.  Note that text 
boxes and pictures can not be selected in “Thumbnail” view, 
while pages can not be selected in “Page” view. 

Text Properties
When a text box is selected, 
the “Properties” palette can 
be used to choose the font, 
font size, color, style (bold 
or italic), and text alignment 
(center, left, or right).

Picture Properties
When a picture is selected, 
the “Properties” palette lists 
the picture name, size, and 
date of recording.

Page Properties 
When a page is selected, 
the “Properties” palette lists 
the page type, background 
color, and contents.  Click the 
Color button to set the page 
background color.

The Layouts Palette
This palette controls the lay-
out of the selected pictures.

Document Template: Choose 
a layout from this menu.  To 
lock the layout so that it 
cannot be changed, choose 
Locked.

Include: Include front or front and back covers.

Include Page Numbers: Number the pages in the layout.

Reset Layout: Clicking this 
button displays the dialog 
shown at right; click Yes to 
restore the default layout for 
the selected template, using 
the pictures selected in edit 
mode or the thumbnail pal-
ette.
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Design Mode: Design Mode: Adding Pictures to a LayoutAdding Pictures to a Layout  

To add pictures to a layout:

1 Select  (“Page”) or  (“Page and Thumbnail”) view.

2 Click the 

▲

 next to Thumb-
nails to open the “Thumb-
nails” palette.

3 Drag a picture from the 
thumbnail list over another 
picture in the layout and 
release the mouse button.  
The picture will be inserted 
in this position and the re-
maining pictures will move 
one position down in the 
layout.  To remove the pic-
ture in the selected position 
from the layout and replace 
with the picture from the 
thumbnail list, press the 
shift key while dragging 
the thumbnail.

Drag thumbnail 
into layout

  Thumbnail ViewThumbnail View
Pictures can not be added in the thumbnail view.  Select the page or 
page and thumbnail view.

  The Thumbnail MenuThe Thumbnail Menu
The thumbnail menu controls what pictures 
are displayed in the thumbnail area.  Choose 
Show All to view all pictures in the current 
collection, Show Used to view only the 
pictures in the current layout, or Show Not 
Used to view only pictures not in the current 
layout.
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To exchange the position of two pictures in the current lay-
out:

1 Select  (“Page”) or  (“Page and Thumbnail”) view.

2 Select a picture, then drag it over another picture in the 
layout and release the mouse button.  The positions of 
the two pictures will be exchanged.

  Thumbnail ViewThumbnail View
Individual pictures can not be reordered in the thumbnail view.  Select 
the page or page and thumbnail view.

  Text BoxesText Boxes
Except in the following templates, text boxes will be moved when 
pictures are reordered: H: Mix 3, H: Simple 3, Q: Mix 3, Q: Mix 4, 
Q: Simple 3, V: Mix 2, V: Mix 3, V: Mix 4, and V: Simple 3. 

Design Mode: Design Mode: Reorganizing PicturesReorganizing Pictures  

To move a page to a new position in the current layout:

1 Select  (“Thumbnail”) or  (“Page and Thumbnail”) 
view.

2 Select a page, then drag it between two pages in the 
layout and release the mouse button.  The selected page 
will be moved to a position between the two pages.

  Page ViewPage View
Pages can not be reordered in the page view.  Select the thumbnail or 
page and thumbnail view.
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Print as:Print as:
Choose Standard Print or 
Index Print.  The setting 
chosen determines the layout 
options available. 

Selected pictures can be printed by clicking the  (Print) 
button in the PictureProject window or select Print… from 
the File menu.  This section describes the options available 
in the “Print” dialog.

Layout as:Layout as:
If Standard print is se-
lected for Print as, choose 
a layout from the options 
shown at right.

Sharing Pictures: Sharing Pictures: Printer SettingsPrinter Settings  1/2

If Index Print is selected 
for Print as,  choose a 
layout from Easy and Ad-
vanced.  Select Advanced 
to choose the horizontal and 
vertical size of the thumbnails 
from separate menus.  Select 
Easy to choose the number 
of thumbnails printed per 
row from the Number of 
Images menu.

Print preview area.  Click  and  buttons 
to preview additional pages.
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Print OptionsPrint Options
Rotate images to fi t: Rotate images to print at the largest 
possible size.

Borderless print: Enlarge pictures to fi ll the page.  Any 
portions of the image that do not fi t on the page will be 
cropped out.

Print multiple copies of each photo: Print multiple copies of 
each image.  The number of copies can be selected from the 
pull down menu.

Print MetadataPrint Metadata
The information that will be 
printed under pictures when 
this option is selected is list-
ed next to Display Under 
Image, the information that 
will be printed on pictures 
next to Display On Image.  
Click the Settings… button 
to choose the information 
printed and fonts used.

Sharing Pictures: Sharing Pictures: Printer SettingsPrinter Settings  2/2

Printer typePrinter type
Inkjet printer: Pictures are 
printed at 360 dpi for optimal 
speed and image quality.  If 
the maximum resolution supported by the printer is less than 
360 dpi, pictures will be printed at the highest resolution 
supported by the printer.

All other printers: Pictures are printed at the highest reso-
lution supported by the printer.  Choose this option when 
printing pictures on dye-sublimation or photographic print-
ers.  Printing speed may drop if this option is selected with 
inkjet printers.

Page setup...Page setup...
Choose paper size, orientation, and print margins.  Paper 
type can not be selected from PictureProject; see the printer 
manual for more information.

Print...Print...
Start printing.

CancelCancel
Close the print dialog without printing.
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Toolbar: Choose whether to display the 
slide show toolbar during the show.

Transitions: Choose from:
• No Effect: Pictures are displayed one 

after the other with no transition 
between them.

• Wipe: Each picture gradually replaces 
its predecessor, starting at the bot-
tom, top, left, or right.

• Slide: Pictures slide into the frame 
from the bottom, top, left, or right.

• Cross Fade: Each picture gradually 
fades out as the next fades in.

• Iris Open / Iris Close: A circle gradually expands or con-
tracts to reveal the next picture.

• Random: PictureProject chooses the transition between 
each picture randomly.

Sharing Pictures: Sharing Pictures: Slide Show and Movie SettingsSlide Show and Movie Settings  1/2

This section describes the settings avail-
able in the slide show window and 
in the dialog displayed at the start of 
movie or slide show playback.  Note 
that movies can not be edited while a 
slide show is in progress.

Music: To play music during the show, 
select Choose music… and choose a 
WAV (.wav) or MPEG (.mp3) track.  To 
turn music off, choose No music.  

Show each image for: Enter the time each image is displayed 
(1–60 seconds).  If a music track has been selected, the dis-
play interval can be adjusted to match the length of the en-
tire slide show to the length of the track by choosing Match 
slideshow to music length.

Manually advance slides: Slides are displayed until the user 
clicks  in the slide show tool bar to view the next slide.

Show fi le information: Display the fi le name and size of pic-
tures in the slide show.

Repeat slideshow: The slide show repeats until stopped.

Always show this dialog before slideshow: Select this option 
to display the settings dialog before the next slide show.  If 
this option is not selected, current settings will apply to all 
subsequent slide shows.  To display the dialog again, click  
in the tool bar and select Show Settings Dialog.

OK / Cancel: Click OK to start the slide show or Cancel to exit 
without starting the show.
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The Slide Show Toolbar
Pressing the tab key during a slide show hides or displays the 
toolbar (if Auto-Hidden is selected for Toolbar in the slide 
show settings dialog, the toolbar will also be displayed when 
the mouse is moved over the bottom of the window).

Sharing Pictures: Sharing Pictures: Slide Show and Movie SettingsSlide Show and Movie Settings  2/2

Button Description

Rotate current photo 90 ° counterclockwise (stills only).

Rotate current photo 90 ° clockwise (stills only).

Retouch current photo (stills only).

Correct red-eye in current photo (stills only).

Turn tag marking for current picture on or off.

Return to previous picture.

Pause / resume slide show playback.

Skip to next picture.

 / 

Display settings menu.  Select Show 
Settings Dialog… to open slide 
show settings dialog, or adjust set-
tings directly using menu options.

Display Music menu.

 / 

To save a slide show as a QuickTime (“.mov”) movie:

1 Select a folder, collection, or pictures for a slide show and 
choose Make Movie… from the Photo menu.

2 The settings dialog will be displayed.  
After adjusting settings as described 
on the previous page, choose a frame 
size from the Movie size menu and 
click OK.  The Repeat slideshow 
and Always show this dialog be-
fore slideshow options are not dis-
played.

3 The standard Windows or Mac OS “Save As” dialog will 
be displayed.  Choose a fi le name and location and click 
Save.  The resulting movie will automatically be cataloged 
in PictureProject under Last Import.  See “Movies” for 
information on playback.

Select collection or 
pictures…

… and select 
Photo > Make 

Movie... 

Collection list Picture list

Exit slide show.
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Sharing Pictures: Sharing Pictures: E-mail SettingsE-mail Settings  

One index print photo (single attachment): Send “contact 
sheets” that list multiple pictures side-by-side in a single at-
tachment.  The following options are available:
• Size: The size at which the 

attachments will be sent.
• Quality: Move the slider to 

the left to reduce fi le size, 
to the right to improve im-
age quality.

• Layout: The number of pictures per attachment.
• Names: Include the name listed in the “Information” pal-

ette under each picture.
• Background color: Choose the background color.

Send / CancelSend / Cancel
Click Send to send the pictures, or Cancel to close the e-
mail dialog without sending the pictures.

Send asSend as
Multiple photos (attachments): Send each picture as a sepa-
rate attachment.  The following options are available:
• Size: The size at which the 

attachments will be sent.
• Quality: Move the slider to the left to reduce fi le size, to 

the right to improve image quality.

Clicking the  (Mail) button in the PictureProject window 
or selecting Email… from the File menu displays the dialog 
shown below.

Preview area.  Click 
 and  buttons 

to preview addition-
al attachments.

  E-mailE-mail
An Internet connection and supported e-mail application are required 
to use the PictureProject e-mail option.  The user bears all applicable 
fees charged by the phone company or Internet service provider.

  Supported E-mail ApplicationsSupported E-mail Applications
PictureProject supports the following e-mail applications:
• Windows: Outlook Express, Outlook, Eudora
• Macintosh: Entourage X, Mail, Eudora
PictureProject uses the computer’s default e-mail program.  The default 
program can be selected using the Internet options in the Con trol Panel 
(Win dows) or by starting Mail and choosing the default mail program in 
the “General” tab of the preferences dialog (Mac OS X).
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The “Burn CD / DVD” dialog contains the following options.  
Multi-session DVDs can not be recorded under Mac OS X 
or with DVD+RW discs.  Multi-session DVDs created under 
later versions of Windows can not be read in Windows Me 
or Windows 98.  DVD-RAM is not supported.

Disc NameDisc Name
Enter a volume name for the disc.  The 
default name is based on the current 
date and time.

Number of CopiesNumber of Copies
Choose the number copies by clicking 
the arrows or entering a number in the 
text box.

Burn asBurn as
Original Photos: Copy pictures to disc without change. This 
option can not be used with layouts. 

Optimized JPEG Photos: Save the pictures or layout as JPEG 
images.  The following options are available:
• Size: The size at which the pictures will be saved.
• Quality: Move the slider left to reduce fi le size, right to 

improve quality.
• Include QuickTime Slideshow Movie: Include a QuickTime 

movie slide show of the pictures in the selected collec-
tion or folder.  Note that the resulting movie (named 
“Slideshow.mov”) can not be viewed or cataloged 
in PictureProject and must instead be viewed using 
QuickTime-compatible software.

• Include Based on MPV Slideshow Document: Create a 
playlist for MPV- (Music- Photo-Video) compatible DVD 
players.  The album will be named “album.pvm.”

Upgrade…Upgrade…
Click for upgrade information on the Burn option.

Sharing Pictures: Sharing Pictures: The “Burn CD/DVD” DialogThe “Burn CD/DVD” Dialog  1/2

  MPV (Music-Photo-Video)MPV (Music-Photo-Video)
Selecting Include Based on MPV Slideshow Document creates 
MPV-compatible CDs or DVDs in a format that also supports movies 
(MPV-IS not supported).  The resulting disc can be viewed on MPV-
compatible DVD players.

  Saving Pictures from Multiple FoldersSaving Pictures from Multiple Folders
When saving pictures from several different folders to CD or DVD, 
create a new folder in the collection list to hold only the collections 
or pictures that will be saved.  For each collection in the new folder, a 
corresponding folder will be created on the disc.  If All Photos or Last 
Import is selected when the disc is created, all pictures will be copied 
to the root directory of the CD or DVD.  Pictures with the same name 
will be renamed by adding a number to the fi le name.

  Multiple DiscsMultiple Discs
If the selected folder or collection contains more pictures than will fi t on 
a single disc, multiple discs will be created.
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Continue…Continue…
Clicking Continue… displays the fol-
lowing options:
• Burn using: Select the drive that will 

be used to create the disc.
• Speed: Choose a supported write 

speed.
• Enable buffer-underrun protection: Pause recording and 

buffer data when the drive can not keep pace.  This op-
tion is only available if the drive supports this feature.

• Disc Options: Choose Finalize disc after burning or Allow 
more data to be added to disc after burning.  Note that 
additional data can not be recorded to fi nalized discs.

• Erase disc before burning: Delete existing data before re-
cording (rewriteable discs only; requires more than 20 min. 
if “Allow more data…” is selected with DVDs).  Do not 
use this option if the disc contains valuable data.

• Verify disc after burning: Verify disc after recording.
• Burn: Begin writing the selected pictures to disc.  This but-

ton is not available if the selected drive does not contain a 
writable disc or if no suitable drive can be found.

• Close: Return to the previous dialog.

To exit without creating discs, click Cancel in either of the 
“Burn CD / DVD” dialogs.

Viewing Discs
To view CDs or DVDs created using PictureProject Version 
1.5 or later, simply insert the disc into a drive.  The disc will 
appear in the collection list with a  icon next to its name.

  Edit and Design ModesEdit and Design Modes
Edit and design mode options can not be used with pictures on a CD 
or DVD.  Copy the pictures to the computer hard disk for editing and 
layout.

  Earlier Versions / Other ProgramsEarlier Versions / Other Programs
PictureProject 1.5 or later can not be used to view pictures on discs 
created with earlier versions of PictureProject.  Copy the pictures to the 
computer hard disk for viewing.

PictureProject can not add data to rewriteable discs containing data 
recorded by other programs.  Such discs can be used for multi-session 
recording if all existing data are fi rst erased.
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Select
Photos / Movies…: Display the “Select Photos / Movies” dialog, where you can 
select pictures for the Pictmotion video.

Music…: Display the “Select Music” dialog, where you can select back-
ground music for the Pictmotion video.

Style…: Display the “Select Style” dialog, where you can choose from a va-
riety of video styles.

Captions…: Display the “Select Captions” dialog, where you enter opening 
and closing titles.

Sharing Pictures: Sharing Pictures: Pictmotion Options (Windows Only)Pictmotion Options (Windows Only)  1/4

The “Pictmotion” option is used to create Pictmotion videos from the pictures selected in the picture list or, if no pictures 
are selected, from the pictures in the current collection or folder.  Clicking the  (Pictmotion) button displays the follow-
ing dialog:

Produce
Auto Produce…: Display the “Auto Produce” dialog, where you can create the 
Pictmotion video.

Save…: Display the “Save” dialog, where you can select a format and save 
the Pictmotion video.

Preview
Use the controls in this area to preview pictures, music, 
or the completed Pictmotion video.

Close: Close the “Pictmotion 
by muvee” dialog.

Upgrade…: View Pictmotion 
upgrade information.
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The “Select Photos / Movies” Dialog
Choose the pictures or movie clips 
that will be included in the Pictmotion 
video.
• Remove: Remove the selected item 

from the playlist.
• Restore: Restore all items in the origi-

nal order.
• : Move the selected item up or down in the playlist.

The “Select Music” Dialog
Create a background track for the 
Pictmotion video.
• Add…: Add a .wav, .mp3, .wma, or 

.m4a fi le to the background track.
• Remove: Remove the selected fi le 

from the background track.
• : Move the selected fi le up or 

down in the playlist.
• Audio Mix: Move the slider to the left to raise the volume 

of the background track and lower the volume of the se-
lected video, or move the slider to the right to raise the 
volume of the selected video and lower the volume of the 
background track.

  MoviesMovies
Movie clips are resized to the aspect ratio of the preview window in the 
Pictmotion dialog.
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The “Auto Produce” Dialog
Join the selected pictures into a 
Pictmotion video.  Choose Automatic 
duration to match length to content, 
or Manual duration to choose the 
length of the video manually.  For lon-
ger durations, select Allow photos and video segments 
to be repeated.  Select Allow audio clips to be repeat-
ed to repeat the background track for the full length of the 
video.  Click Continue to return to the “Pictmotion” dialog 
and create the Pictmotion video.

The “Select Style” Dialog
Choose an editing style for the 
Pictmotion video.  The current version 
of PictureProject supports “Classic Se-
pia,” “Over-the-Top Music Video,” and 
“Pro: Medium.”  Selecting “Get More 
Styles…” displays Pictmotion upgrade information.  Select 
Keep shots in sequence to show pictures in the order given 
in the “Select Photos / Movies” dialog.

The “Select Captions” Dialog
Add opening titles and closing credits 
to the Pictmotion video.
• Let Pictmotion choose the fonts: Let 

Pictmotion choose fonts automati-
cally.  Deselect this option to choose 
fonts with the Select Font buttons.

• Opening Titles: Enter opening titles.
• Closing Credits: Enter closing credits.

To save changes to any of the above settings and return to 
the “Pictmotion” dialog, click OK.  Click Cancel to exit with-
out saving changes.
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  Supported E-mail ApplicationsSupported E-mail Applications
PictureProject supports Outlook Express, Outlook, and Eudora.

The “Save” Dialog
Choose Computer Playback to save 
the video to disk, or E-mail to send the 
video as an e-mail attachment. 
• Format: If Computer Playback is 

selected, choose Windows Media 
Video or MPEG1.  E-mail attachments 
are sent in Windows Media format.

• Video Type: If MPEG1 is selected for 
Format, choose the analog video 
signal type from NTSC and PAL.

• Quality: Options range from Best (best 
quality) to Good (smallest fi le size).

• Frame Size: If Windows Media Vid-
eo is selected for Format, choose 
the frame size from this menu.

• Save fi le to computer (e-mail only): Save a copy of the e-
mail attachment to disk.

Click Save to proceed.  If E-mail is selected, an empty e-
mail message will be created with the video as an attach-
ment.  To exit without saving the video, click Cancel.  Click 
Upgrade… to view Pictmotion upgrade information.

Computer playback

E-mail

The Preview Area

Control

Photos / Videos

Photos Music
Auto Produce

 / Save

Select previous —

— Stop

Select next —

— Play / pause / 

Mute audio

Choose spot 
in music or 
video clips

Adjust
volume

To preview pictures, music, or completed Pictmotion 
video, select appropriate Preview button.

Videos
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The following dialog will be displayed.  Enter an Account 
Holder’s Name, a User Name that will appear in the “From” 
line of all P-Mails sent, and the E-Mail Address that will ap-
pear as the sender’s e-mail address.  Choose a language and 
country from the Language / Country menu and click OK.

To use Nikon FotoShare’s free picture-sharing service (avail-
able only to Nikon customers in Europe), you must set up an 
account with Nikon FotoShare.  This entitles you to share pic-
tures and enjoy the other benefi ts available to Nikon own-
ers.  This section details the registration process.  For more 
information on using FotoShare, see “Sharing Pictures with 
FotoShare” and FotoShare’s on-line help.

The fi rst time you start Nikon FotoShare, the following dialog 
will be displayed.  Click Register.

  On-line RegistrationOn-line Registration
An Internet connection is required to register.  The user bears all appli-
cable fees charged by the phone company or Internet service provider.

  Dial-up ConnectionsDial-up Connections
When using a dial-up connection, be aware that the connection is not 
automatically terminated when registration is complete.  Be sure to ter-
minate the connection manually.

The dialog shown at right will be dis-
played when registration is complete.  
Click OK.  Nikon will automatically send 
an e-mail confi rming registration.

  Privacy PolicyPrivacy Policy
For information on Nikon’s privacy policy, click the Privacy Policy but-
ton in the registration dialog (Internet connection required).
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To view pictures on a TiVo DVR (Windows only):

1 Select a collection or folder in the collection list and click 
the  TiVo button.

2 The dialog shown at right 
will be displayed.  If a col-
lection was selected in Step 
1, the dialog will list all cur-
rent collections.  If a folder 
was selected, the dialog will 
list the collections in the se-
lected folder.  Select the 
collections containing the 
pictures you wish to share.  
Click Select All to select all listed items, or Deselect All 
to deselect all listed items.

3 Click Share Items to make the pictures in the selected 
collections available for viewing on a TiVo DVR.

4 The dialog shown at right 
will be displayed when 
the operation is complete.  
Click OK.

5 To view the pictures, start TiVo Server (included in TiVo 
Desktop) and select Music & Photos from the “TiVo 
Central” screen.

… and click 
TiVo

Collection list

Select collection…

  TiVoTiVo
This option requires a TiVo DVR and TiVo Desktop, available for down-
load from the TiVo website.  For more information, see the documenta-
tion provided on the TiVo website or with your TiVo DVR.

  RAW (NEF) PicturesRAW (NEF) Pictures
RAW (NEF) pictures will not display correctly if TiVo Desktop is installed 
after PictureProject.  Reinstall PictureProject after installing TiVo Desk-
top.

  “All Photos” / “Last Import”“All Photos” / “Last Import”
If All Photos or Last Import is selected in the collection list when you 
click the  TiVo button, the “TiVo” dialog will list all collections that 
are currently shared.  No collections will be displayed if no collections 
are currently shared.
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To display the PictureProject preferences, select Option… 
from the Tools menu (Windows) or Preferences… from 
the application menu (Mac OS X).

The preferences dialog contains the following tabs: “Gen-
eral,” “Color Management,” and “Rename Photos”.

After making changes to preferences, click OK to return to 
PictureProject, or click Cancel to cancel changes and return 
to PictureProject.

GeneralGeneral
The “General” tab contains 
the following options:

Auto Launch: If Auto launch 
PictureProject when a 
camera or memory card 
is connected is selected, 
PictureProject Transfer will 
launch automatically when 
a camera is connected or a 
memory card is inserted.

Dialog Windows: Click Reset 
to reset the “Don’t show this 
dialog again” option for all 
dialogs.

MacintoshWindows

Macintosh

Windows
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Color Management (Color Management (WindowsWindows))
Choose color management 
profi les for displaying im ag es 
on the monitor, ed it ing and 
printing RGB images, and 
saving CMYK-TIFF images.

Default RGB color space: 
Lists the output color-space 
profi le used when work ing 
with RGB images.  If Use 
this instead of an em bed ded profi le when opening 
fi les is checked, this RGB color space profi le will be used for 
all images.  If it is not checked, the profi le embedded in each 
image will be used.

Convert image(s) to sRGB color space when they are e-
mailed or converted into JPEG format: PictureProject uses 
the sRGB color space profi le for e-mail, or export.  Pictures 
already in sRGB are not affected.

Change Display Profi le: Opens the Windows “Display Prop-
erties” dialog; select “Settings” and click Advanced… to 
view display adapter properties.  To select a display profi le, 
open the “Color Management” tab and click Add.

Other Settings: Other Settings: PreferencesPreferences  2/3

Printer profi le: Lists the profi le used for printing.

Use profi le for printing: If this option is checked, a profi le 
can be selected by clicking Browse….  The selected pro-
fi le will appear in the adjacent text box.  If this option is 
not checked, the default RGB color space will be used.

Intent: If Use profi le for printing is selected, the type 
of match ing per formed can be selected from Rel a tive 
and Per cep tu al.  Choose Relative to use the closest 
colors available when printing colors not in the gamut 
of the selected profi le.  Choose Perceptual to compress 
the colors in the image to fi t the gamut of the selected 
profi le.  De pend ing on the pro fi le, chang ing the match ing 
meth od may produce no change in output.  Matching is 
not available with some profi les; con sult the man u fac tur er 
for de tails.

CMYK separation profi le: Lists the profi le used when work-
ing with CMYK-TIFF images.  To choose a dif fer ent profi le, 
click Browse….

  Color ManagementColor Management
With the exception of Convert image(s) to sRGB color space when 
they are e-mailed or converted into JPEG format, color manage-
ment settings also apply to Nikon Capture (available separately).  The 
display profi le applies system wide.



Index Getting Started PictureProject Tutorial PictureProject Reference Technical Notes

Next 54BackTop

Color Management (Color Management (MacintoshMacintosh))
The Macintosh Color Man-
agement tab lists the follow-
ing profi les:

RGB Default: Choose the de-
fault RGB color-space profi le.

CMYK Default: Choose the 
default CMYK color-space profi le.

Always use this profi le instead of embedded profi le: Use 
the default RGB profi le when working with pictures in 
PictureProject and the default CMYK profi le when convert-
ing RGB pictures to CMYK.  If this option is not checked, the 
profi le embedded in each image will be used.

Use sRGB color space for digital output Email or JPEG format: 
PictureProject uses the sRGB color space profi le for e-mail, or 
export.  Pictures already in sRGB are not affected.

Change Display Profi le…: Open the “Displays” System Pref-
erence.  Select “Color” to choose a new display profi le.

Other Settings: Other Settings: PreferencesPreferences  3/3

Printer profi le: Lists the profi le used for printing.

Use profi le for printing: If this option is checked, a profi le 
can be selected from the Printer menu.  If this option is 
not checked, the default RGB color space will be used.

Intent: If Use profi le for printing is selected, the type 
of match ing per formed can be selected from Rel a tive 
and Per cep tu al.  Choose Relative to use the closest 
colors available when printing colors not in the gamut 
of the selected profi le.  Choose Perceptual to compress 
the colors in the image to fi t the gamut of the selected 
profi le.  De pend ing on the pro fi le, chang ing the match ing 
meth od may produce no change in output.  Matching is 
not available with some profi les; con sult the man u fac tur er 
for de tails.

  Color ManagementColor Management
With the exception of Use sRGB color space for digital output 
Email or JPEG format, color management settings also apply to Nikon 
Capture (available separately).  The display profi le applies system wide.
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PictureProject is equipped with an automatic update function 
known as Nikon Message Center.  Nikon Message Center 
checks for updates to a variety of Nikon digital products, in-
cluding PictureProject.  If the computer is connected to the 
Internet, Nikon Message Center will automatically check for 
updates when PictureProject starts.  You can also check for 
updates by selecting Check for Updates… from the Help 
menu.  If an update is available, an update dialog will be 
displayed.

  PrivacyPrivacy
Information provided by the user as part of this service will not be given 
to third parties without the user’s permission.

  Downloading UpdatesDownloading Updates
An Internet connection is required to download updates.  The user 
bears all applicable fees charged by the phone company or Internet 
service provider.

  Dial-up ConnectionsDial-up Connections
When using a dial-up connection, be aware that the connection is not 
automatically terminated when download is complete.  Be sure to ter-
minate the connection manually.

Rename PhotosRename Photos
Choose how PictureProject 
names new pictures.  See 
“Transfer Options: The ‘Re-
name Photos’ Tab” for more 
information.  Changes to 
these settings also apply to 
import, the Import Assistant, 
and the “Rename Photos” 
tab in the “Transfer Options” 
dialog.
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